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2 Grundlagen und Methoden 
Dieses Kapitel beschreibt die technischen Grundlagen der Magnetresonanztomographie 

(MRT), die Pathophysiologie des Hirninfarkts, erläutert die Grundlagen der interaktiven 

Segmentierung mittels Snake-Verfahren sowie der computergestützten Datenauswertung und 

gibt Informationen zu Patienten und Datenmaterial. 

2.1 Magnetresonanztomographie (MRT) 

In diesem Abschnitt werden die historische Entwicklung des MRT, die physikalischen 

Grundlagen und die verwendeten Untersuchungstechniken beschrieben. Außerdem werden 

die Begriffe Diffusionswichtung (DWI) und Apparenter Diffusionskoeffizient (ADC) 

eingeführt. 

2.1.1 Historische Entwicklung 

Felix Bloch und Edward Purcell zeigten 1946 experimentell unabhängig voneinander, dass 

Atomkerne in der Lage sind, hochfrequente elektromagnetische Wellen zu absorbieren, wenn 

sie von einem externen Magnetfeld umgeben sind. Voraussetzung für diese Kernspinresonanz 

ist, dass die Frequenz der zusätzlich eingestrahlten Hochfrequenzimpulse mit der 

Eigenfrequenz der Atomkerne, der so genannten Larmorfrequenz, übereinstimmt. Felix Bloch 

und Edward Purcell erhielten 1952 für diese Entdeckung den Nobelpreis für Physik. 

Bereits 1973 veröffentlichte der US-Amerikaner Paul C. Lauterbur herausragende Ergebnisse 

der Magnetresonanztechnik in der Projektion und Rekonstruktion [1]. 1977 gelangen R. 

Damadian et al. magnetresonanztechnische Aufnahmen des Thorax am lebendigen 

menschlichen Körper [19]. Auf den Aufnahmen waren zumindest Herz, Mediastinum und 

Aorta eindeutig zu differenzieren. Damadian et al. erkannten bereits 1977 die klinische 

Relevanz zur Tumordiagnostik [20]. Allerdings waren die Aufnahmezeiten mit mehreren 

Stunden für die praktische Anwendung viel zu lang. 

Der Brite Sir Peter Mansfield beschleunigte die Aufnahmetechnik 1978 durch zeilenweises 

Auslesen der Bilddaten [21]. Er wurde zusammen mit Paul C. Lauterbur im Jahre 2003 für 

seine Verdienste mit dem Nobelpreis für Medizin und Physiologie ausgezeichnet. 

1983 begann der dauerhafte klinische Einsatz der Magnetresonanztomographie in 

Deutschland mit der Installation von Magnetresonanztomographen in Wiesbaden und 
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Hannover. Diese Methode fand klinisch zunehmend Akzeptanz und wurde insbesondere für 

die Diagnostik des Zentralen Nervensystems (ZNS) zur Methode der Wahl. Vorteile 

gegenüber anderen bildgebenden Verfahren sind neben dem hohen Weichteilkontrast die 

fehlende Strahlenbelastung, die Möglichkeit Bilder in allen Schichtorientierungen 

anzufertigen, sowie die fehlende Beeinträchtigung der Bildqualität durch dichte Knochen [2]. 

Ein weiterer Vorteil ist die Vielfältigkeit der Informationen, die durch unterschiedliche 

Untersuchungstechniken gewonnen werden können. 

Zu den klassischen Untersuchungstechniken zählen Aufnahmen, die auf unterschiedlichen 

Relaxationszeiten der Gewebe (T1- und T2-gewichtete Aufnahmen) beruhen. Moderne Unter-

suchungstechniken, wie z.B. diffusions- und perfusionsgewichtete Aufnahmetechniken, erlau-

ben es, zusätzlich physiologische oder funktionelle Gewebeeigenschaften zu beurteilen [3]. 

2.1.2 Physikalische Grundlagen 

2.1.2.1 Präzession 

Atomkerne besitzen einen Eigendrehimpuls um ihre Drehachse, den so genannten Kernspin. 

Werden Atomkerne in ein externes Magnetfeld B0 gebracht, so richten sich die durch die 

Rotation des Kerns induzierten magnetischen Momente entlang B0 aus. Zusätzlich bewirkt die 

Wechselwirkung mit dem Drehimpuls eine Präzessionsbewegung (siehe Abbildung 2.1) [22]. 

B0

Präzession

Magnetisches Moment
des Atomkerns

Atomkern

 
Abbildung 2.1: Präzessionsbewegung des magnetischen Moments von Atomkernen im externen 
Magnetfeld B0 
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2.1.2.2 Larmorfrequenz 

Die Larmorfrequenz (ω0) ist nach dem britischen Physiker Joseph Larmor benannt und 

bezeichnet die Frequenz, mit welcher das magnetische Moment des Atomkerns um das 

Magnetfeld präzediert. Sie ist zur Stärke des Magnetfelds proportional und berechnet sich 

nach der Larmor Gleichung: 

00 2
B

π
γω =        (1) 

wobei ω0 die Larmorfrequenz in Herz, B0 die Magnetfeldstärke in Tesla des angelegten 

Magnetfeldes und γ die gyromagnetische Konstante bezeichnet. 

Beispielsweise beträgt die Larmorfrequenz des Wasserstoffkerns bei einem Magnetfeld von 

• 0,5 Tesla 21,28 MHz, 

• 1,0 Tesla 42,57 MHz, 

• 1,5 Tesla 63,86 MHz. 

2.1.2.3 Resonanz 

Wird ein Atomkern extern mit einem Hochfrequenzimpuls B1 einer Trägerfrequenz der 

Larmorfrequenz angeregt, welcher 90° zum statischen Magnetfeld B0 steht, ist ein 

Resonanzphänomen zu beobachten, bei dem der Atomkern die Energie des 

Hochfrequenzimpulses besonders effektiv absorbiert (siehe Abbildung 2.2). 

 

Atomkern

Hochfrequenzimpuls
(B ) im Winkel von 90°
zum Magnetfeld 
mit Larmorfrequenz

1

 
Abbildung 2.2: Resonanz tritt auf, wenn ein Hochfrequenzimpuls (B1) im Winkel von 90° zum 
Magnetfeld (B0) mit der Larmorfrequenz mit einem Atomkern wechselwirkt. 
 

Der Effekt der Resonanz ist, dass sich neben der anfänglichen Longitudinalmagnetisierung 

(entlang der Richtung z des externen Magnetfeldes B0) eine dazu senkrechte Transversal-
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magnetisierung in der x,y-Ebene ausbildet, welche bei der Magnetresonanztomographie in 

ihrem zeitlichen Verlauf gemessen wird. 

2.1.2.4 Relaxation 

Nach der initialen Energieaufnahme von B1 gibt der Atomkern die absorbierte Energie wieder 

ab und die Magnetisierung kehrt in ihre Ruhelage in longitudinaler Richtung z zurück. Nach 

diesem Relaxationsprozess kann der Atomkern erneut angeregt werden. 

Unterschieden wird zwischen longitudinaler (T1) und transversaler (T2) Relaxation [22]: 

• Die T1-Relaxation resultiert aus der Wiederherstellung der longitudinalen 

Magnetisierung nach Energieabgabe an das umliegende Gewebe. 

• Die T2-Relaxation resultiert in der Abnahme der Transversalmagnetisierung, 

hervorgerufen durch Interaktionen zwischen den Magnetfeldern benachbarter 

Atomkerne. Dies äußert sich durch eine Dephasierung der Magnetisierung in der 

transversalen Ebene. 

In Abhängigkeit der Aufnahmeparameter resultieren hieraus T1- bzw. T2-gewichtete Bilder. 

2.1.3 Untersuchungstechniken 

Zur Erzeugung des magnetresonanztomographischen Datenmaterials existieren eine Reihe 

von unterschiedlichen Aufnahmetechniken. Die wichtigsten Verfahren sind das klassische 

Spin-Echo-Verfahren, das Gradienten-Echo-Verfahren und die ultraschnelle Echo Planar 

Imaging (EPI) Aufnahmetechnik, welche in der vorliegenden Arbeit verwendet wird [22].  

2.1.3.1 Echo Planar Imaging (EPI) Aufnahmetechnik 

Die ultraschnelle EPI Aufnahmetechnik bietet gegenüber den klassischen Aufnahmetechniken 

den Vorteil, dass alle Zeilen der Bildmatrix einer Aufnahmeschicht mit nur einer Anregung 

ausgelesen werden. Die Aufnahmezeit einer Schicht liegt mit ca. 150 ms deutlich unter einer 

Sekunde, wodurch sich die Untersuchungszeit drastisch gegenüber den klassischen 

Aufnahmetechniken reduziert und somit die Voraussetzung für komplexe Aufnahmeserien 

geschaffen wird. 
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2.1.3.2 Aufnahmeparameter 

Die resultierende magnetresonanztomographische Aufnahme hängt entscheidend von den 

gewählten Aufnahmeparametern ab. Im folgenden werden die wichtigsten Aufnahmepara-

meter vorgestellt: 

• Pulswiederholzeit TR (Time to Repeat): Zeitdauer zwischen zwei aufeinander 

folgenden Hochfrequenzanregungsimpulsen B1 in Millisekunden. Die T1-Zeit wech-

selwirkt mit der Pulswiederholzeit, da sie den Grad der Relaxation zwischen zwei 

Hochfrequenzimpulsen bestimmt. Die Pulswiederholzeit geht multiplikativ in die 

Gesamtaufnahmezeit ein. 

• Echozeit TE (Time to Echo): Zeitintervall zwischen Hochfrequenzanregungsimpuls 

und dem Maximum des resultierenden Signals in Millisekunden. Die Wahl der 

Echozeit ist direkt mit der Abnahme der Transversalmagnetisierung vor Signal-

auslesung verknüpft. Bewegungsartefakte werden durch kurze Echozeiten unterdrückt. 

• Anregungswinkel: Der Anregungswinkel bestimmt die Anfangsgröße der 

Transversalmagnetisierung. Sie ist bei einem Anregungswinkel von 90° maximal und 

wird so beispielsweise beim Spin-Echo-Verfahren verwendet. Beim Gradienten-Echo-

Verfahren wird gewöhnlich durch Optimierung zwischen reduziertem Anregungs-

winkel und Relaxationszeiten eine reduzierte Echo- und Pulswiederholzeit und somit 

eine reduzierte Gesamtaufnahmezeit erreicht. 

• Bildmatrix: Auflösung des Bildes in Bildpunkten. In der vorliegenden Arbeit wird 

eine Bildmatrix von 256x256 Bildpunkten verwendet. 

2.1.4 Diffusionswichtung (DWI) 

Diffusion beruht auf der thermischen Translationsbewegung von Molekülen, welche auch 

Brown’sche Molekularbewegung genannt wird. Die zurückgelegten Distanzen liegen dabei in 

den Größenordnungen einzelner Zellen. Insbesondere stellt die Wasserdiffusion eine Methode 

zur Untersuchung der Zellintegrität und -pathologie dar. 

Ein Vorteil der diffusionsgewichteten Bildgebung gegenüber den konventionellen T1- und T2-

gewichteten Bildern besteht in ihrer großen Sensitivität auf frühe Veränderungen bei 

zerebraler Ischämie [17, 23, 24]. Die Erhöhung der relativen Signalintensität in den 
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diffusionsgewichteten Bildern gibt Hinweise auf eine veränderte Diffusion des Wassers 

innerhalb des ischämischen Gewebes. 

2.1.4.1 Aufnahmetechnik 

Durch Magnetfeldgradienten lassen sich Wassermoleküle bezüglich ihrer Position markieren. 

Somit können ihre Bewegungen über einen gegebenen Zeitraum gemessen werden. Bereits 

1965 wurden erste Diffusionsmessungen mit Hilfe der Magnetresonanz durchgeführt [25]. 

Diagnostisch verwertbare Anwendungen beim Menschen sind erst durch leistungsfähige 

Gradientensysteme möglich geworden, wobei die in der vorliegenden Arbeit verwendete 

ultraschnelle EPI Aufnahmetechnik besonders zur Diffusionsbildgebung geeignet ist.  

Im Bereich geringer Diffusion, z.B. im Bereich eines akuten Schlaganfall, ergibt sich eine 

relative Signalhyperintensität im Vergleich zum gesunden Gewebe mit normaler Diffusion. 

Die Signalintensität im diffusionsgewichteten Bild hängt unter anderem noch von den 

Relaxationszeiten T1 und T2 und somit von den Aufnahmeparametern (Pulswiederholzeit, 

Echozeit, etc.) ab.  

2.1.5 Apparenter Diffusionskoeffizient (ADC) 

Um die Wirkung der Diffusion von der anderer Parameter zu trennen und um ein quantitatives 

Maß für zugrunde liegende pathophysiologische Vorgänge zu erhalten, wird die räumliche 

Verteilung (Map) des apparenten Diffusionskoeffizienten (ADC) berechnet. Der b-Wert, das 

Maß der Diffusionswichtung, berechnet sich zu: 

)
3

(222 δδγ −Δ= Gb ,      (2) 

wobei γ das gyromagnetische Verhältnis, δ die Gradientendauer, G die Gradientenamplitude 

und Δ die Länge des diffusionsgewichteten Gradienten angeben. Der b-Wert hat die Einheit 

s/mm². 

Zur Berechnung des ADC nach Stejskal und Tanner [25] wird der Signalabfall einer nicht 

diffusionsgewichteten Aufnahme S0 (b-Wert = 0) mit den Signalintensitäten SI der 

diffusionsgewichteten Aufnahme für jeden Bildwert berechnet und durch den berechneten b-

Wert dividiert:  

)lnln(1
0SSI

b
ADC −= ,      (3) 
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wobei die Aufnahmeparameter der einzelnen Untersuchungen konstant sein müssen. 

Der ADC wird in der vorliegenden Arbeit in der Einheit [μm²/s] angegeben. Eine ADC-Map 

ist die ortsaufgelöste Darstellung der rechnerisch ermittelten ADC Werte. Es werden fünf 

diffusionsgewichtete Aufnahmen mit den b-Werten 0, 232, 511, 736, 1001 zur Berechnung 

einer ADC-Map verwendet. Zu beachten ist, dass sich für die ADC-Maps ein umgekehrtes 

Kontrastverhalten im Vergleich zu den diffusionsgewichteten Aufnahmen ergibt, d.h. dass 

pathologische Areale mit geringer Diffusion, die in der diffusionsgewichteten Aufnahme hell 

erscheinen, in der ADC-Map dunkel abgebildet werden (siehe Abbildung 2.3). 

Die quantitative Darstellung des ADC hat sich zu einem wichtigen Kriterium zur 

Untersuchung von Patienten mit akuten Schlaganfall entwickelt [16, 26-28]. 

 

1 2 3

Infarktregion Pathophysiologie  
Abbildung 2.3: Darstellung eines großen Media-Infarktes rechts mit Hilfe der T2-Wichtung (1), der 
Diffusionswichtung (2) und der ADC-Map (3). In der Diffusionswichtung (2) ist die Infarktregion am 
deutlichsten vom umliegenden Gewebe abgrenzbar. In der ADC-Map (3) stellt sich die Patho-
physiologie dar. (1) und (2) sind experimentelle EPI Aufnahmen, (3) ist die berechnete ADC-Map (b-
Werte = 0, 232, 511, 736 und 1001 s/mm²). 
 

2.2 Der Hirninfarkt 

Dieser Abschnitt beschreibt die Epidemiologie, Symptomatik, Äthiopathogenese, 

Differenzialdiagnose und Therapie des Hirninfarkts. Hierbei wird im wesentlichen auf den 

ischämischen Hirninfarkt und seiner wichtigsten Differenzialdiagnose, dem hämorrhagischen 

Hirninfarkt, eingegangen. Außerdem wird die Entwicklung des apparenten Diffusions-

koeffizienten (ADC) im Verlauf des Hirninfarkts vorgestellt. 
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2.2.1 Epidemiologie 

Die Zahl der zerebrovaskulären Neuerkrankungen beträgt in Deutschland ca. 200-

350/100.000 Einwohner pro Jahr (Inzidenz). Die Prävalenz liegt bei 600/100.000 

Einwohnern. Als größter Risikofaktor wird die arterielle Hypertonie angegeben [29]. Das 

Erkrankungsrisiko steigt mit zunehmenden Lebensalter, wobei Männer häufiger als Frauen 

betroffen sind. Weitere Risikofaktoren sind Herzerkrankungen, Diabetes mellitus und 

Nikotinabusus. Der Hirninfarkt liegt hinter den kardiovaskulären und tumorösen 

Erkrankungen an dritter Stelle der deutschen Mortalitätsstatistik [29]. 

2.2.2 Symptomatik 

Der Hirninfarkt setzt meist schlagartig ein, schreitet dann nicht mehr fort und bildet sich 

meistens nur unvollständig zurück. In vielen Fällen gehen dem Hirninfarkt transitorische 

ischämische Attacken (TIA) voraus. Ein reversibles ischämisches neurologisches Defizit 

(RIND) liegt vor, wenn sich der Hirninfarkt innerhalb von drei Wochen vollständig 

zurückbildet. Als pathologisches Korrelat findet man beim kompletten Infarkt eine 

Kolliquationsnekrose (Encephalomalacia alba), in die es sekundär einbluten kann 

(Encephalomalacia rubra) [29]. 

Die Symptomatik der Großhirninfarkte unterscheidet sich in Abhängigkeit des betroffenen 

arteriellen Versorgungsbereichs: 

• Im Versorgungsbereich der A. cerebri anterior entwickelt sich häufig eine 

kontralaterale beinbetonte Hemiparese. Außerdem kann es zu unwillkürlichen 

Bewegungen der kontralateralen Hand kommen. 

• Im Versorgungsbereich der A. cerebri media entwickelt sich häufig eine brachiofazial 

betonte Hemiparese, eine Hemihypästhesie, sowie eine Blickdeviation zur Seite des 

Infarktes. 

• Im Versorgungsbereich der A. cerebri posterior entwickelt sich häufig eine homonyme 

Hemianopsie (Gesichtsfeldausfall) und eine Hemihypästhesie. Außerdem kann es zu 

einer Dyslexie kommen, falls die dominante Hemisphäre betroffen ist.  

Ein Hirnstamminfarkt kann mit vielfältigen Symptomen einhergehen, wie 

Hirnnervenausfällen, Blickparese, Paraparese oder Tetraparese. 
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Kleinhirninfarkte können unter anderem Koordinations-, Sprech-, Stimmstörungen, 

Nystagmus und Muskelhypotonie verursachen. 

Bei unklarer Bewusstlosigkeit ist der akute Hirninfarkt eine wichtige Differentialdiagnose, 

insbesondere, weil die typische lokalisationshinweisende Symptomatik fehlen kann. 

2.2.3 Äthiopathogenese des ischämischen Hirninfarkts 

Aufgrund der mangelnden Durchblutung kommt es beim ischämischen Hirninfarkt zu fokalen 

Störungen des zerebralen Funktions- und Strukturstoffwechsels. Hierbei wird morphologisch 

zwischen einer Makro- und Mikroangiopathie unterschieden. 

Bei Makroangiopathie finden sich 

• Thromboembolische Hirninfarkte, welche intrakraniell durch gelöste Plaques der 

Hirnarterien oder kardiogene Thromben entstehen können; 

• Hämodynamisch verursachte Hirninfarkte, welche hauptsächlich durch extrakranielle 

Stenosen verursacht werden. Durch Abfall des Perfusionsdrucks kommt es dabei zur 

Ischämie im Bereich der Endstrombahn.  

Bei Mikroangiopathie finden sich 

• Lakunäre Infarkte häufig als Folge der Hyalinisierung intrazerebraler Arterien bei 

chronischer arterieller Hypertonie und Diabetes mellitus; 

• Die subkortikale arteriosklerotische Enzephalopathie (Binswanger-Krankheit). 

Annährend 30% der ischämischen Hirninfarkte werden durch kardiale Embolien verursacht. 

Risikofaktoren stellen die absolute Arrhythmie bei Vorhofflimmern, ein offenes Foramen 

ovale, Klappenvegetationen, sowie intrakardiale Thromben dar [30]. 

2.2.4 Differenzialdiagnose des ischämischen Hirninfarkts 

Mit 5-15% sind intrazerebrale Blutungen (ICB) nach dem ischämischen Hirninfarkt die 

zweithäufigste Ursache des Hirninfarkts. Sie treten bevorzugt in den Basalganglien, den 

Großhirnhemisphären, dem Thalamus und der hinteren Schädelgrube auf. Die ICB tritt in der 

Regel spontan auf und häufig kommt es zu einer Progredienz der klinischen Symptomatik in 

den ersten Stunden, welche sich in einem breitem Spektrum vom fokal-neurologischen Defizit 

bis zu Bewusstseinstörungen äußern kann. Die sichere Abgrenzung einer ICB von einem 

ischämischen Hirninfarkt ist nur durch bildgebende Verfahren, wie die Computer- und die 

Magnetresonanztomographie möglich. Hierbei gewinnt die Magnetresonanztomographie 
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zunehmend an Bedeutung, da es mit Hilfe der diffusionsgewichteten Bildgebung und des 

ADC möglich ist, Hirninfarkte schon innerhalb der ersten Minuten nach Auftreten des 

Infarktereignisses zu beurteilen.  

Zu den selteneren Differentialdiagnosen gehört die Subarachnoidalblutung, welche sich 

klinisch meistens durch akut einsetzende heftige Kopfschmerzen und Nackensteife äußert. In 

den überwiegenden Fällen ist ein Aneurysma der Hirnbasisarterien die Blutungsquelle einer 

Subarachnoidalblutung. Je nach Symptomatik kommen etliche weitere Differentialdiagnosen 

in Betracht, wie z.B. die Sinusvenenthrombose, Migräne mit zerebralen Herdsymptomen, 

fokale Epilepsie, metabolische Störungen, Vergiftungen, Hirntumoren und -metastasen. 

2.2.5 Akuttherapie des ischämischen Hirninfarktes 

Zur Basistherapie des Hirninfarktes gehören die Aufrechterhaltung eines ausreichenden 

Perfusionsdrucks, die Stabilisierung des Blutzuckers und der Sauerstoffversorgung. 

Entscheidend ist weiterhin ein schneller Transport in ein geeignetes Zentrum (Stroke-Unit) 

zur Hirninfarktakutbehandlung und weiteren Diagnostik, insbesondere weil eine 

Lysetherapie nur innerhalb eines zur engen Zeitfensters begonnen werden kann. 

Voraussetzung für die Lysetherapie ist der Ausschluss einer Hirnblutung durch bildgebende 

Verfahren. Hierzu eignen sich die Computertomographie (CT) und die 

Magnetresonanztomographie. In Deutschland ist die systemische Lysetherapie bisher mit dem 

rekombinanten Tissue Plasminogen Activator rtPA zugelassen, welcher das körpereigene 

Plasminogen aktiviert und somit eine Fibrinolyse einleitet [30]. 

Einschlusskriterien für die Lysetherapie sind [30]: 

• Alter 18-80 Jahre 

• Klinisches Bild eines akuten Hemisphäreninfarkts 

• Behandlungsbeginn innerhalb von 3 Stunden (in Ausnahmefällen bis 6 Stunden) in 

einer Stroke-Unit  

Ausschlusskriterien für die Lysetherapie sind [30]: 

• Unklarer Zeitpunkt des Beginns der neurologischen Symptomatik 

• Klinisches Bild eines malignen Mediainfarktes (fixierte Blickdeviation, Hemiplegie, 

Bewusstseinstrübung) 

• Rasche Symptomrückbildung 

• „minor stroke“ mit minimalen Ausfällen 
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• Älterer Hirninfarkt oder Schädel-Hirn-Trauma in den letzten 3 Monaten 

• Frühere Subarachnoidalblutung oder intrazerebrale Blutung 

• Schwer kontrollierbare Hypertonie (>200 mmHg trotz Therapie) 

• Erhöhtes Blutungsrisiko bei: 

o Endogener oder exogener Gerinnungsstörung 

o Zustand nach Operation (<21 Tage) 

o Punktion eines nicht abdrückbaren Gefäßes (<7 Tage), Lumbalpunktion 

o Antikoagulation 

o Ösophagusvarizen, Ulcus duodeni, Kolitis, Bauchaortenaneurysma 

• Zerebraler Krampfanfall bei Schlaganfallbeginn 

• Konsumierende Grunderkrankung (Malignome, Lebenserwartung unter 6 Monaten) 

• Kraniale Bildgebung: Blutung, Tumor, schwere Mikroangiopathie 

Eine alternative zur systemischen Lysetherapie stellt die lokale Lysetherapie dar, welche 

erfolgreich im vertebrobasilären System angewendet wird [31]. 

2.2.6 Entwicklung des ADC im Verlauf des Hirninfarktes 

In der Akutphase des Hirninfarktes tritt meist schon nach mehreren Minuten ein zytotoxisches 

Ödem auf, welches nur mit der diffusionswichtenden Bildgebung nachweisbar ist. Nach 

mehreren Stunden entwickelt sich zusätzlich ein vasogenes Ödem, welches in 

computertomographischen Aufnahmen und in den T2-gewichteten magnetresonanz-

tomographischen Aufnahmen nachweisbar ist. 

T2

ADC

Zeit seit Infarktbeginn~7d ~14d

I II III IV

 
Abbildung 2.4: Schematisierter zeitlicher Verlauf der Veränderungen von ADC und T2 beim 
Hirninfarkt des Erwachsenen. Vier Abschnitte können unterschieden werden: (I) ADC vermindert und 
T2 normal; (II) ADC vermindert und T2 erhöht; (III) ADC normal (Pseudonormalisierung) und T2 
erhöht; (IV)  ADC und T2 erhöht. 
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In Abbildung 2.4 ist ein schematischer Zeitverlauf mit den zu erwartenden Veränderungen der 

Parameter ADC und T2 im Laufe des Hirninfarkts bei Erwachsenen dargestellt [32]. 

In der Akutphase vermindert sich zunächst der ADC durch das zytotoxische Ödem, ohne dass 

die T2-gewichtete Bildgebung signifikante Veränderungen zeigt. Nach mehreren Stunden 

steigt mit Eintreten des vasogenen Ödems das Signal in der T2-gewichteten Bildgebung 

signifikant an [6]. Mit Einsetzen der Nekrose kommt es zu einer Umkehr der ADC-

Veränderungen, da die Diffusion des Wassers weniger eingeschränkt ist, nach ca. 3-10 Tagen 

hat sich der ADC pseudonormalisiert [24]. Von ADC Pseudonormalisierung wird gesprochen, 

da es sich trotz weiterhin bestehender Pathologie um eine kurzfristige ADC Normalisierung 

handelt. In dieser Phase ist nur der T2-Wert diagnostisch aussagekräftig [33]. Daher wird 

empfohlen, eine kombinierte Diffusions-/T2-Analyse zur Beurteilung des Verlaufs nach 

Hirninfarkt einzusetzen. 

2.3 Interaktive Segmentierung mittels Snake-Verfahren 

Das Snake-Verfahren, auch „Active Contour Model“ genannt, ist ein Verfahren zur 

interaktiven Segmentierung von Bilddaten. Hierbei wird ein Bildabschnitt initial durch den 

Anwender des Bildverarbeitungsprogramms durch eine Region of Interest (ROI) markiert. 

Anschließend deformiert der Segmentierungsalgorithmus die initiale ROI, bis sie sich der zu 

markierenden Gewebestruktur möglichst optimal angepasst hat. Grundlage hierfür ist das 

Prinzip der Energieminimierung, wobei eine äußere externe Energie in Korrespondenz zur 

internen Energie der zu markierenden Gewebestruktur steht. 

2.3.1 Grundlagen 

Die Grundlagen für Snake-Verfahren wurden 1988 von Kass et al. beschrieben [8]. 1994 

wurden erste Anwendungen von Snake-Verfahren in der medizinischen Bildanalyse von 

Porrill et al. durchgeführt [9]. Verschiedene klinische Anwendungen folgten unter anderem in 

der Sonographie [10], Kardiologie [11] und Radiologie [12]. 

Snake-Verfahren werden typischerweise durch ein Energiepotential angetrieben, welches aus 

den zugrunde liegenden Bilddaten berechnet wird. Mit Bildverarbeitungsalgorithmen werden 

Extrema aus Bilddaten herausgefiltert, welche Gewebestrukturgrenzen im Originalbild 

entsprechen. Diese Extrema bilden ein Energiepotential, welches den Snake über eine Serie 

von Iterationen dazu bewegt, sich möglichst genau der Kantenstruktur des zu markierenden 
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Gewebes anzupassen. Dabei wird die Energie, die den Snake zur Bewegung antreibt, umso 

geringer, je näher sich der Snake der eigentlichen Kantenstruktur annähert. Die Iterationen 

werden dabei so lange fortgesetzt, bis eine Maximalzahl erreicht ist oder der Snake nur noch 

minimale Änderungen erfährt, welche unter einem Schwellwert liegen. Abbildung 2.5 zeigt 

im Modell, wie sich ein Snake auf eine Gewebestruktur zu bewegt. 

Gewebestruktur

 
Abbildung 2.5: Die Abbildung zeigt einen geschlossenen Snake zur Iteration I (durchgezogene Line), 
welcher sich auf eine Gewebestruktur (grau unterlegt) zu bewegt und den resultierenden Snake zur 
Iteration I+1 (gestrichelte Linie). Mit fortschreitender Iterationszahl nähert sich der Snake der 
Gewebestruktur immer weiter an, bis er sich den Rändern der Gewebestruktur (fast) vollständig 
angepasst hat. Das Abbruchkriterium (siehe Text) legt fest, wie genau sich der Snake der 
Gewebestruktur annähert. 

2.3.2 Klassisches Verfahren 

Im folgenden werden die mathematischen Grundlagen des klassischen Snake-Verfahrens 

vorgestellt. 

Der Snake wird von folgenden Energiekomponenten  beeinflusst: 

• Interne Energie (Eintern): Verleiht dem Snake Spannung und sorgt für weitestgehende 

Homogenität der Snakekontur.  

• Externe Energie (Eextern): Wird dem Snake von äußeren Quellen auferlegt, z.B. 

indem der Anwender interaktiv die Gewebestruktur initial grob markiert und damit die 

Startpunkte des Snake-Algorithmus festlegt. 

• Bildenergie (Eimage): Bewegt den Snake zu hervorstehenden Bildmerkmalen, wie z.B. 

zu Kontrastübergängen von hellen und dunklen Bildregionen. 

Der Snake wird in der Parameterform mit Hilfe der Koordinaten seiner Bildpunkte  

r(s) = ( x(s), y(s) ) repräsentiert, wobei der Parameter s zwischen 0 und 1 normiert ist. 

Die totale Energie des Snake Esnake ist gegeben als die Summe der einzelnen 

Energiekomponenten: 
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2.3.2.1 Interne Energie 

Die interne Energie (Eintern) setzt sich aus einem Term erster Ordnung für die Spannung 

(Tension) und einem Term zweiter Ordnung für die Steifheit (Stiffness) zusammen: 
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wobei α und β Parameter des klassischen Snake-Algorithmus bzgl. der internen Energie sind 

und in Abhängigkeit des gegebenen Bildmaterials variiert werden können. Die Spannung und 

Steifigkeit führen dazu, dass sich der Snake in einem gewissen Umfang wie ein elastisches 

Band bewegen kann. 

2.3.2.2 Externe Energie 

Die externe Energie (Eextern) bestimmt, inwieweit der Snake durch äußere Faktoren und 

Vorgaben in seinem Verlauf beeinflusst wird. Beispielsweise kann der Snake durch den 

folgenden Term zu einen Bildpunkt i gezogen werden: 
2rik)r(Eextern −=       (8) 

wobei die Attraktivität des Bildpunktes i für den Snake vom Parameter k festgelegt wird. 

2.3.2.3 Bildenergie 

Die Bildenergie (Eimage) induziert eine Kraft, welche den Snake zu hervorstehenden 

Bildmerkmalen zieht. Sie setzt sich aus einer Linienbildenergie (Eline) und einer 

Kantenbildenergie (Eedge) zusammen: 

edgeedgelinelineimage EwEwE +=      (9) 

wobei wline und wedge als Parameter der Bildenergie die wichtigsten Parameter des klassischen 

Snake-Verfahrens darstellen, da sie die Attraktivität  des Snake zu Gewebeübergängen 

festlegen. Die Feineinstellung dieser Parameter bestimmt wesentlich die resultierende 
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Bildsegmentierung. Das Vorzeichen des Parameters wline legt dabei fest, ob der Snake von 

dunklen (wline positiv) oder hellen (wline negativ) Bildregionen angezogen wird. 

 

2.3.2.4 Linienbildenergie 

Die Linienbildenergie (Eline) ist die einfachste Bildenergie, welche die Attraktivität von hellen 

und dunklen Regionen auf den Snake bestimmt: 

∫=
1

0
ds))s(r(IEline       (10) 

wobei I(r) die Intensität des Bildes am Snakepunkt r angibt. 

Mit ∇ für den Bildgradienten ergibt sich für die induzierte Kraft δr: 

)(rI
r
Ir −∇=
∂
∂

−≅δ .      (11) 

2.3.2.5 Kantenbildenergie 

Die Kantenbildenergie (Eedge) basiert auf Extrema der Bildenergie, wobei starke Änderungen 

der Bild-Grauwerte mit hohen Kantenenergiewerten korrelieren. Die Kanten werden durch 

eine gradientenbasierte Potentialfunktion berechnet: 
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r
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wobei I(r) die Intensität des Bildes am Snakepunkt r angibt. 

Mit einem Snakepunkt r = (x, y) und einer Bildenergie 2)(rIEimage ∇−=  ergibt sich für die 

induzierte Kraft der Kantenbildenergie: 
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2.3.3 Das SplineSnake-Verfahren 

Seit der Beschreibung durch Kass et al. [8] wurde das Snake-Verfahren kontinuierlich 

weiterentwickelt. Das klassische Snake-Verfahren hat hierbei eine explizite interne Energie 

(s. 2.3.2.1), welche dem Snake innere Spannung und Homogenität verleiht. Durch andere 

Repräsentationsformen, wie Fourierdarstellungen [34] und B-splines [35] gelingt es, eine 
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implizite Spannungs- und Glättungskomponente direkt in die Snakekurve zu bringen, 

wodurch die interne Energie als explizite Komponente im Snake-Algorithmus an Bedeutung 

verliert.  

In dieser Arbeit wird das SplineSnake-Verfahren von M. Jacob et al. verwendet, welches das 

Snake-Verfahren mittels kubischen B-Splines umsetzt [13]. Hierbei wird der Snake direkt als 

B-Spline Kurve dargestellt, indem die Snake-Stützstellen als Ankerpunkte der B-Splines 

benutzt werden, wodurch die interne Energie der klassischen Snake-Darstellung überflüssig 

wird. Weiterhin verwendet das SplineSnake-Verfahren eine generalisierte Bildenergie Eimage, 

welche sich aus einem gradientenbasierten Energieanteil Egradient und einem regionbasierten 

Energieanteil Eregion zusammensetzt: 

regiongradientimage EEE βα +=      (14) 

wobei α und β die Parameter der jeweiligen Gewichtung der Energieanteile sind. 

Der Snake wird wiederum in der Parameterform mit Hilfe der Koordinaten seiner Bildpunkte 

r(s) = ( x(s), y(s) ) repräsentiert. 

2.3.3.1 Gradientenbasierte Bildenergie 

Mit dem Gradienten ∇ und der Bildintensität I am Snakepunkt r ergibt sich für die 

gradientenbasierte Bildenergie Egradient: 

∫ ∇=
Sgradient ds))s(r(IE 2      (15) 

wobei S das Areal innerhalb der Snakekurve bezeichnet. 

Der Vorteil der gradientenbasierten Bildenergie liegt in der Detektion der genauen Kanten-

übergänge. Somit gelingt es, Gewebeübergänge präzise zu trennen. Der Nachteil der 

gradientenbasierten Bildenergie ist die schlechte Erfassung von Gewebestrukturen, welche 

sehr weit von der initialen Snakekontur entfernt liegen. Weiterhin ist die gradientenbasierte 

Bildenergie anfällig für Störeinflüsse (Bildrauschen) und hat Schwierigkeiten, sich an 

konkave Bildkonturen anzupassen [36]. 

2.3.3.2 Regionbasierte Bildenergie 

Die Nachteile der gradientenbasierten Bildenergie können durch die regionbasierte 

Bildenergie eliminiert werden, welche Vorteile hinsichtlich der Unempfindlichkeit gegenüber 
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Störeinflüssen (Bildrauschen) besitzt. Weiterhin ist die regionbasierte Bildenergie besser in 

der Lage konkave Bildkonturen wiederzugeben. Diese Eigenschaften beruhen auf der 

Tatsache, dass die regionbasierte Bildenergie den gesamten (vom Snake umschlossenen) 

Bildausschnitt berücksichtigt, wohingegen die gradientenbasierte Bildenergie aufgrund des 

mathematischen Verfahrens die Bildanteile vernachlässigt, welche weit vom initialen Snake 

entfernt liegen.  

Unter der Annahme, dass die Bildpunkte unabhängige randomisierte Variablen sind, lässt sich 

die statistische Regionsfunktion von Staib und Duncan ansetzen [37]: 

ds
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wobei S und S’ die Areale innerhalb und außerhalb der Snakekurve bezeichnen und P die 

Wahrscheinlichkeit für die Intensität I eines Bildpunktes r an den Snakepositionen s ∈ S bzw. 

s ∈ S’ angibt. 

2.4 Automatische, histogrammbasierte Segmentierung 

Zur klassischen magnetresonanztomographischen Bildanalyse und Segmentierung wurden 

bereits eine Vielzahl von automatischen Analysetechniken entwickelt [3, 4, 38-40]. Im 

Gegensatz zu interaktiven Segmentierungsverfahren, wie den Snake-Verfahren, handelt es 

sich hierbei um Methoden, welche ohne Interaktion von erfahrenem medizinischen Personal 

eingesetzt werden können. Aus diesem Grund eignen sich diese Verfahren besonders für 

Screeninguntersuchungen. Bei einem positiven Ergebnis sollten danach allerdings zusätzliche 

Analysetechniken, wie z.B. die interaktive Segmentierung mittels Snake-Verfahren, 

angewandt werden, um das Ergebnis hinsichtlich seiner Sensitivität zu validieren. 

Die in der vorliegenden Arbeit verwendeten magnetresonanztomographischen Daten wurden 

bereits mit einem automatischen histogrammbasierten Verfahren ausgewertet [41]. Grundlage 

dieser Auswertung sind die Arbeiten von Braun et al. zur automatischen Segmentierung von 

Hirninfarkten auf Grundlage von T2- und diffusionsgewichteten Aufnahmen [3, 5, 42]. 

Eine Histogrammdarstellung ergibt sich aus den Häufigkeiten der spezifischen Grauwerte der 

magnetresonanztomographischen Aufnahmen, welche entlang einer Grauwertskala 

aufgetragen werden (siehe Abbildung 2.6). Histogramme repräsentieren Eigenschaftsräume. 



 22

Die Dichtemaxima der in den Eigenschaftsraum abgebildeten Grauwerte fungieren als 

Ankerpunkte für die Erkennung von beliebig geformten zusammenhängenden Bereichen 

(Clustern). Sie werden nach der Segmentierung im Eigenschaftraum zurück in den Bildraum 

transformiert, wo sie unterschiedliche Gewebetypen repräsentieren. Zur Segmentierung eines 

Gewebes im Eigenschaftsraum wird ausgehend von der Histogrammzelle mit der höchsten 

Population der Cluster ausgedehnt, bis eine kontinuierliche Grenze erreicht ist. Diese wird 

durch zusammenhängende Dichteminima von Histogrammzellen definiert [43]. 
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Abbildung 2.6: Generierung eines 1D-Histogramms (rechts) zu einer diffusionsgewichteten 
magnetresonanztomographischen Aufnahme eines Infarktpatienten (links). Im 1D-Histogramm sind 
die relativen Häufigkeiten der Bildgrauwerte entlang einer Grauwertskala aufgetragen. Der Bereich im 
Histogramm links der gestrichelten Linie repräsentiert den dunklen Bildhintergrund und wird in einem 
Vorverarbeitungsschritt abgetrennt. 
 
Ein Nachteil der histogrammbasierten Segmentierung liegt in der Übersegmentierung, d.h. es 

werden durch das Analyseverfahren mehr Cluster segmentiert als tatsächlich existierende 

Gewebetypen vorhanden sind. Hieraus ergibt sich für eine verbesserte Diagnostik die 

Notwendigkeit zur Anwendung zusätzlicher Bildverarbeitungsroutinen oder die Anwendung 

interaktiver Segmentierungsmethoden, wie die in der vorliegenden Arbeit verwendete 

interaktive Segmentierung mittels Snake-Verfahren. 

2.5 Computergestützte Datenauswertung 

Ebenso wie die Magnetresonanztomographie hat sich auch die computergestützte 

Datenauswertung in den letzten Jahrzehnten rasant entwickelt. Heutzutage ist es möglich, 

komplexe Analyseverfahren mit einem Personalcomputer oder tragbaren Notebook 

durchzuführen. Umso wichtiger ist, bei ebenfalls stetig steigenden Datenmengen, eine präzise 

definierte, plattformunabhängige Programmumgebung zu verwenden. Diese Programm-
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eigenschaften werden durch die moderne objektorientierte Programmiersprache Java 

unterstützt [44]. 

2.5.1 Programmiersprache Java 

Die Entwicklung der Programmiersprache Java begann 1991 bei Sun Microsystems® und 

wurde seitdem ständig weiterentwickelt [44]. Die Entwickler versuchten bereits etablierte 

Konzepte der Programmiersprachen C und C++ in die Entwicklung einfließen zu lassen und 

erweiterten diese um Konzepte zur sicheren und dynamischen Codegenerierung. Ein weiterer 

Vorteil der Programmiersprache Java besteht in der Plattformunabhängigkeit, d.h. ein 

generiertes Java Programm kann auf allen gängigen Betriebssystemplattformen ausgeführt 

werden, wie z.B. Microsoft Windows®, Sun OS®, Mac OS® und Linux. 

Java Programme werden im stetig zunehmenden Umfang auf der gesamten Welt entwickelt 

und werden dabei vielfach als Public Domain oder Open Source Programme inklusive 

Quellcode übers Internet frei zur Verfügung gestellt. Zu diesen frei verfügbaren Programmen 

gehört auch ImageJ, welches in der vorliegenden Arbeit als Grundlage zur 

computergestützten Datenauswertung und Integration neuer Funktionalitäten, wie im 

vorliegenden Fall der Snakes-Verfahren, verwendet wird. 

2.5.2 Bildverarbeitung und Analyse in Java mittels ImageJ 

ImageJ (Image Processing and Analysis in Java) ist ein Public Domain Java Programm zur 

Bildverarbeitung und –analyse, welches von den National Institutes of Health (USA) unter 

Leitung von W. Rasband entwickelt wird und inklusive Quellcode frei verfügbar ist [18]. Es 

ist Nachfolger des Programms NIHImage [45], welches für den Macintosh® entwickelt 

wurde. 

2.5.2.1 Installation und Start von ImageJ 

ImageJ ist als ZIP-Archiv erhältlich, welches auf dem jeweiligen Zielrechner entpackt werden 

muss. Anschließend kann ImageJ mittels des Shell-Skripts „start.bat“ unter Windows bzw. 

„start.sh“ unter Linux oder Sun OS gestartet werden. Voraussetzung ist eine installierte Java 

Entwicklungsumgebung ab Version 1.3. Von dem Shell-Skript wird der Java-Interpreter mit 

der ImageJ Basisklasse „ij.ImageJ“ gestartet, welche das Programm selbstständig initialisiert. 

Unter Windows enthält das Shell-Skript folgende Programmzeile: 
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c:\programme\java\jdk1.3.1_09\bin\java -mx400m -ms50m -cp 

".\build;.\AIPDev.jar" -DPlugins.dir="." ij.ImageJ 

wobei „c:\programme\java\jdk1.3.1_09\bin\java“ den Java-Interpreter unter dem gegebenen 

Pfad mit folgenden Programmoptionen startet: 

• „-mx400m“: Erhöht den maximal zu verwendeten Hauptspeicher auf 400 MB. 

Standardwert ist hierbei 80 MB. 

• „-ms50m“: Setzt den initialen zu verwendenden Hauptspeicher auf 50 MB. 

• „-cp CLASSPATH“: Gibt den relativen Pfad zu den Programmdateien an. In diesem 

Fall ist CLASSPATH „.\build;.\AIPDev.jar“, da sich die Programmdateien in „.\build“ 

befinden und zusätzlich die Bibliothek „.\AIPDev.jar“ in aktuellen Verzeichnis 

eingebunden wird.  

• „-DPlugins.dir=PATH“: Gibt den relativen Pfad zu dem Verzeichnis mit den ImageJ 

Plugins (siehe 2.5.3) an. In diesem Fall ist PATH „.“, da sich das ImageJ Plugin 

Verzeichnis im aktuellen Verzeichnis befindet. 

• „ij.ImageJ“: Startet die Basisklasse „ij.ImageJ“, welche das eigentliche Programm 

initialisiert. 

2.5.2.2 Arbeiten mit ImageJ 

Abbildung 2.7 zeigt das Startfenster von ImageJ mit Menüleiste und Toolbar. Folgende 

Basisoperationen stellt ImageJ zur Verfügung: 

• File→Import: Stellt verschiedene Importfilter unter anderem zum Rohdatenimport 

bereit. Der Import von Bilddaten im DICOM-Format ist mittels eines Plugins möglich. 

In der kommenden Version von ImageJ soll der DICOM-Import direkt in das Import-

Menü integriert werden. In der vorliegenden Arbeit wurde der Import im 

Rohdatenformat genutzt, weil die Daten an einem Tomographen erhoben wurden, der 

das DICOM-Format noch nicht unterstützt. 

• File→SaveAs: Erlaubt das momentane Bild in verschiedenen Formaten zu speichern, 

wie z.B. Tiff, JPEG und RawData. File→SaveAs→XYCoordinates erlaubt es die 

momentan aktive ROI (Region of Interest) als Punktkoordinaten zu speichern. 

• File→Print: Druckt das aktuelle Bild aus. 

• Edit: Bietet die gängige Undo/Redo, Cut/Copy/Paste – Funktionalität. 
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• Image→Type: Erlaubt die Konvertierung eines Bildes in andere Formate, wie 8-Bit 

und 16-Bit Graustufen und RGB-Farbbildern. 

• Process: Enthält die gängigen Bildverarbeitungsroutinen, wie z.B. Bildfilter, 

Glättungsroutinen, mathematische Operationen auf Bildern (AND, XOR usw.) und die 

Fast Fourier Transformation (FFT). 

• Analyse: Enthält die gängigen Bildanalysefunktionen, wie z.B. die 

Histogrammfunktion (siehe Abbildung 2.6). 

• Plugins: Enthält alle benötigten Funktionen zur ImageJ Pluginverwaltung (siehe Kap. 

2.5.3). 

 

 
Abbildung 2.7: Startfenster von ImageJ mit Menüleiste und Toolbar. In der Toolbar ist der Button für 
eine Polygon ROI Selektion aktiviert. 
 
Mit dem Dialogfenster „File→Import→Raw“ kann eine magnetresonanztomographische 

Aufnahme im Rohdatenformat importiert werden. Abbildung 2.8 zeigt dabei die zu 

verwendenden Parameter für den Rohdatenimport in Abhängigkeit vom Bildformat.  

 
Abbildung 2.8: ImageJ „File→Import→Raw“ Dialog zum Importieren von magnetresonanz-
tomographischen Aufnahmen im Rohdatenformat. Das linke Dialogfenster zeigt die Parameter zum 
Import einer diffusionsgewichteten Aufnahme und das rechte Dialogfenster zeigt die Parameter zum 
Import einer ADC-Map. 
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Um auf einem bestimmten Bildbereich zu arbeiten, muss zuvor eine Region of Interest (ROI) 

selektiert werden. Dies geschieht, indem im Startfenster der Button für die Polygon ROI 

Selektion aktiviert wird (siehe Abbildung 2.7). Anschließend wird die ROI im jeweiligen Bild 

mit der linken Maustaste markiert. Mit einem Doppelklick der linken Maustaste wird die ROI 

Markierung beendet und die soeben definierte ROI erscheint im Bildbereich (siehe Abbildung 

2.9). 

 

 
 
Abbildung 2.9: Diffusionsgewichtete Aufnahme eines Infarktpatienten in ImageJ mit selektierter ROI 
(Region of Interest) 
 

2.5.3 Offene Architektur und Erweiterbarkeit von ImageJ mittels Java 
Plugins 

Die Funktionalität von ImageJ kann mittels Java Plugins universell erweitert werden. Plugins 

können sowohl Funktionalitäten für neue Dateiformate, als auch neue Filter und 

Bildanalysefunktionen bereitstellen. Plugins, welche sich im Plugin Ordner von ImageJ 

befinden, werden beim Start von ImageJ automatisch initialisiert und über das Plugin Menü 

des ImageJ Startfensters (siehe Abbildung 2.7) automatisch dem Anwender zur Verfügung 

gestellt. Andernfalls kann der Benutzer sie über das Dialogfenster unter 

„Plugins→Shortcuts→Install Plugin“ auch an anderer Stelle einbinden. Mit „Plugins→Edit“ 
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kann ein Plugin neu erzeugt oder ein bestehendes Plugin editiert und kompiliert werden. Auf 

der ImageJ Webseite stehen über 150 ImageJ Plugins zum Download zur Verfügung [18]. 

Im Rahmen der vorliegenden Arbeit wurde ImageJ um folgende Plugins erweitert: 

• Convert Roi: Konvertiert ein Graustufenbild mit ROI, so wie es von den Snake 

Plugins bereitgestellt wird, in ein RGB Farbbild mit blau markierter ROI. Dieses 

Farbbild kann als TIF Bild zur späteren Weiterverarbeitung gespeichert werden. 

• ROI Importer: Importiert eine ROI in das aktuelle Bild, welche zuvor als Textdatei 

mittels „File→SaveAs→XY Coordinates“ gespeichert wurde. 

• APIDev Snake: Das klassische Snake-Verfahren aus dem Application Programming 

Interface (API) Projekt (siehe Kap. 2.5.4) als Plugin in ImageJ integriert. 

• SplineSnake: Das SplineSnake-Verfahren (siehe Kap. 2.5.5) als Plugin in ImageJ 

integriert. 

2.5.4 Bildverarbeitungs- und Analyse Application Programming Interface 
(API) Projekt 

Das API Projekt wurde von der Hongkong University of Science and Technology entwickelt, 

um die Entwicklung von Bildverarbeitungsalgorithmen in Java zu unterstützen [46]. Das 

Programmpaket umfasst eine große Sammlung von Matrix- und Bildverarbeitungsfunktionen, 

welche die Implementierung des klassischen Snake-Verfahrens enthält.  

2.5.4.1 Klassischer Snake-Algorithmus des API Projekts 

Der Snake-Algorithmus des API Projekts implementiert im wesentlichen das klassische 

Snake-Verfahren nach Kass et al. [8], wobei folgende Probleme im klassischen Verfahren 

festgestellt wurden: 

• Die Anzahl der Kontrollpunkte einer Snakekontur wurde konstant gehalten. Aus 

diesem Grund variierte die Dichte der Kontrollpunkte, wenn der Snake sich ausdehnt. 

Wenn der Snake zusammenfällt konnte es vorkommen, dass sich die Kontrollpunkte 

überlappen. Das Resultat war, dass unnötig Rechenzeit verbraucht und die Snake-

kontur inhomogen wurde. 

• Aufgrund der Ungenauigkeiten bewegte sich der Snake zu schnell und wurde instabil, 

wenn er nah an das lokale Minimum kam. Das Resultat war, dass der Snake oftmals 

die ursprünglich selektierte Region verlies, was nicht im Sinne des Anwenders war. 
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Um die Probleme zu lösen, wurden beim API Projekt folgende Verbesserungen in das Snake-

Verfahren integriert: 

• Um das Überlappen von Kontrollpunkten zu vermeiden, wird nach jeder Iteration 

geprüft, ob sich auf der gleichen Position schon ein Kontrollpunkt befand. Im 

positiven Fall wird der entsprechende Kontrollpunkt entfernt und die Iteration mit der 

kleineren Kontrollpunktmenge fortgesetzt. 

• Um eine Instabilität der Snakekontur zu vermeiden, wird ein Limit gesetzt, um das 

sich die Snakekontur bei jeder Iteration höchstens bewegen darf. Dadurch wird 

erreicht, das sich der Snake langsam auf die Zielstruktur zu bewegt. 

2.5.4.2 Integration des klassischen Snake-Verfahrens als ImageJ Plugin 

Im Rahmen der vorliegenden Arbeit wurde die Implementierung des klassischen Snake-

Verfahrens aus dem API Projekt als Plugin nach ImageJ integriert. Dazu wurde nur die 

Basisklasse „AIPDev_Snake.java“ angepasst, sodass sie die ImageJ Plugin Schnittstelle 

implementiert. Das übrige API Projekt lies sich als JAR-Archive in das ImageJ Programm 

integrieren. 

Zum Start des „APIDev Snake“ Plugins muss zunächst eine magnetresonanztomographische 

Aufnahme in ImageJ geladen werden und die zu untersuchende Region interaktiv als ROI 

selektiert werden (siehe Kap. 2.5.2.2). Danach wird das Plugin unter „Plugins→APIDev 

Snake“ aufgerufen. Im folgenden Dialogfenster können folgende Parameter eingestellt 

werden, wobei die Einstellungen an das Datenmaterial der vorliegenden Arbeit angepasst 

wurden: 

• wline: Parameter der Linienbildenergie (siehe Kap. 2.3.2.4). Positive Werte bedeuten 

eine Attraktivität zu dunklen, negative eine zu hellen Regionen. Als Einstellung für 

die Datenauswertung wird -0,2 verwendet, weil Infarktregionen in 

diffusionsgewichteten Aufnahmen hell erscheinen. 

• wedge: Parameter der Kantenbildenergie (siehe Kap. 2.3.2.5). Als Einstellung wird 

0,10 verwendet. 

• alpha: Parameter der internen Energie für die Steifheit der Snakekontur (siehe Kap. 

2.3.2.1). Als Einstellung wird 1,0 verwendet. 
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• beta: Parameter der internen Energie für die Spannung der Snakekontur (siehe Kap. 

2.3.2.1). Als Einstellung wird 1,0 verwendet. 

• step size: Parameter für die Schrittgröße zwischen zwei Iterationen. Als Einstellung 

wird 1,0 verwendet. 

• maximal number of iterations: Legt die maximale Anzahl der Iterationen fest. Die 

Einstellung wird mit 200 relativ hoch gewählt, da die meisten Snake Berechnungen 

schon nach ca. 50 Iterationen konvergieren. 

• epsilon: Konvergierungsgröße. Wenn die Änderungen der Snakepositionen nach 

einem Iterationsschritt kleiner als epsilon sind, dann wird die Iteration abgebrochen. 

Als Einstellung wird mit 0,01 ein um den Faktor 10 kleinerer Wert als im API Projekt 

verwendet. 

Die Parameter wline und wedge stellen die wichtigsten Eingabegrößen für den klassischen 

Snakealgorithmus dar. Von ihrer Wahl in Abhängigkeit der Beschaffenheit des Bildmaterials 

hängt entscheidend das Ergebnis des Snake-Verfahrens ab. 

Die Dauer zur Snake-Berechnung mit dem klassischen Snake-Verfahren hängt im 

wesentlichen von der Konvergierungsgröße epsilon, der maximalen Anzahl der Iterationen, 

der Schrittgröße und dem verwendeten Bildmaterial ab. Auf einem gängigen Personal-

computer dauert die Berechnung eines Snakes zwischen einer und fünf Sekunden. 

2.5.5 Integration des SplineSnake-Verfahrens in ImageJ 

Als zweites Verfahren wird neben dem klassischen Snake das SplineSnake-Verfahren zur 

Datenauswertung verwendet [13]. Das SplineSnake-Verfahren ist bereits als Plugin für 

ImageJ erhältlich, sodass das SplineSnake ZIP-Archiv lediglich in das Plugin Verzeichnis 

entpackt werden muss [47]. 

Zum Start des Plugins muss zuerst die Bilddatei in ImageJ geladen werden. Anschließend 

wird das SplineSnake Plugin unter „Plugins→SplineSnake“ aktiviert. Die interaktive 

Segmentierung des zu untersuchenden Bildausschnittes mittels B-Splines findet im Plugin 

statt. Nach der Plugin Aktivierung erscheint die SplineSnake Toolbar anstelle der ImageJ 

Toolbar (s. Abbildung 2.10). Mit Hilfe des linken Buttons („Enter/Move knots“) lässt sich 

leicht die initiale ROI mittels B-Splines festlegen. Anschließend lässt sich der Snake mit dem 

schlangenförmigen Button starten. Mit dem Herz-Button lassen sich die Snake Parameter 
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festlegen. Nach Beenden des SplineSnake Plugins wird der resultierende Snake als Polygon 

ROI in ImageJ angezeigt und kann weiterverarbeitet werden. 

 

 
Abbildung 2.10: ImageJ mit aktiviertem SplineSnake Plugin.  Die SplineSnake Toolbar erscheint 
anstelle der ImageJ Toolbar. 
 
Die SplineSnake Parameter sind in zwei Gruppen unterteilt. Die Parameter des grafischen 

Benutzerinterface (GUI) sind für die Snake Initialisierung verantwortlich und die Snake 

Parameter für die eigentliche Snake Berechnung maßgebend. 

An GUI Parametern sind verfügbar: 

• Optimization: Gibt den Optimierungsgrad während der Kurveninitialisierung an. Als 

Einstellung zur Datenauswertung wurde „Medium“ verwendet. 

• Knot Spacing: Zwischenraum zwischen den Snake Kontrollpunkten. Als Einstellung 

wird der kleinste mögliche Wert 4 verwendet, um eine möglichst genaue Darstellung 

zu erreichen. 

• Step Size: Größe des Schrittes während der Optimierung bei der Initialisierung. Hier 

wird der Standardwert 1,0 übernommen. 

• Smoothing radius: Wird zur Anpassung des Bildes an den Bildgradienten verwendet. 

Hier wird der Standardwert 2,0 übernommen. 

An Snake Parametern sind verfügbar: 

• Image Energie: Gewichtung zwischen gradientenbasierter und regionbasierter 

Bildenergie (siehe 2.3.3.1 und 2.3.3.2). Für das in dieser Arbeit verwendete 

Datenmaterial wird die Einstellung „100% Gradient“ gewählt. Durch die 

ausschließliche Verwendung der gradientenbasierten Bildenergie ist auch die beste 

Vergleichbarkeit mit dem klassischen Snake-Verfahren gegeben. 

• Max Interations: Maximale Anzahl der Iterationen. Als Einstellung wird 3000 

verwendet. 

• Step Size: Größe der Schritte während der Berechnung des Snake. Als Einstellung 

wird 1,0 verwendet. 
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• Accurancy: Gibt den Einfluss der Ausgangsmarkierung auf den resultierenden Snake 

an. Die Accurancy kann hierbei Werte zwischen 1,0 (Einfluss maximal) und 0,01 

(Einfluss minimal) annehmen. Mit 0,05 wurde eine Einstellung zur Datenauswertung 

gewählt, welche einen nicht zu großen Einfluss der Ausgangsmarkierung zulässt. 

• Smoothing radius: Einfluss des berechneten Gradienten auf die Bildglättung. Hier 

wird der Standardwert 2,0 übernommen. 

Der SplineSnake-Algorithmus gestattet noch die Definition von Constraints als zusätzliche 

externe Energie. Diese Komponente wurde allerdings in der vorliegenden Arbeit nicht 

verwendet, da sie dem Anwender gestattet, einen zu großen Einfluss auf die SplineSnake 

Auswertung zu nehmen. Damit wäre eine objektive Datenauswertung nicht mehr 

gewährleistet. 

Die Dauer der Berechnung des Snakes mit dem SplineSnake-Verfahren hängt wie beim 

klassischen Snake-Verfahren im wesentlichen von der maximalen Anzahl der Iterationen, der 

Schrittgröße und dem verwendeten Bildmaterial ab. Auf einem gängigen Personalcomputer 

dauert die Berechnung zwischen einer und fünf Sekunden. 

2.6 Patienten und Datenmaterial 

2.6.1 Patienten 

Es wurden insgesamt 28 Patienten, davon 13 weibliche und 15 männliche untersucht. Das 

Durchschnittsalter der Patienten beim Infarkt betrug 64,28 +/- 12,67 Jahre. Das durch-

schnittliche Infarktalter bei der Untersuchung war 4,95 +/- 3,31 Tage und variierte zwischen 4 

Stunden und 20 Tagen. Für die Untersuchung lag die Einwilligung der Ethikkommission vor. 

Die Einwilligung der Patienten erfolgte schriftlich nach umfassender Aufklärung. 

2.6.2 Aufnahmetechnik 

Die Bilddaten wurden mit einem 1,5 T Magnetom Vision Tomographen (Siemens, Erlangen) 

mit einer Standardkopfspule aufgenommen. Das Untersuchungsprotokoll bestand aus T1-, T2- 

und diffusionsgewichteten Bildern. 

Die diffusionsgewichtete Bildgebung erfolgte mit einer Single-Shot-EPI-Sequenz mit 

bipolaren diffusionsgewichteten Gradienten [3]. Die Diffusionswichtung lag bei axialer 

Schichtführung in Richtung phase-encoding (rechts-links im Patienten), d.h. waagerecht in 
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den Aufnahmen. Es wurden jeweils 20 Schichten mit einer Dicke von 5 mm und einem 

Schichtabstand von 1 mm aufgenommen. Die Größe des FOV (field of view) war 230 mm, 

die geräteinterne Aufnahmematrix von 96x128 Pixel wurde auf 256x256 Pixel interpoliert. 

Die Pulswiederholzeit (TR) betrug drei Sekunden und die Echozeit (TE) 110 Millisekunden. 

Mit einer Aufnahme wurden fünf diffusionsgewichtete Bilder mit den b-Werten (0, 232, 511, 

736 und 1001 s/mm²) als Maß für die Qualität der Diffusionswichtung erfasst. Aus den fünf 

diffusionsgewichteten Aufnahmen wurde jeweils eine ADC-Map berechnet (siehe 2.1.5). Die 

Gesamtaufnahmedauer betrug mit Zusatzanforderungen, wie beispielsweise Magnetresonanz-

Angiographien, maximal 35 Minuten. 

2.6.3 Statistische Auswertung des Datenmaterials 

Die mittels Snake-Verfahren segmentierten Bilder wurden gegen den Goldstandard, der von 

einem Radiologen durch manuelle Segmentierung bestimmt wurde, quantitativ ausgewertet. 

Hierzu werden folgende Parameter erfasst (siehe Abbildung 2.11): 

• rp: richtig positive Werte • fp: falsch positive Werte 

• rn: richtig negative Werte • fn: falsch negative Werte 

 

 

Goldstandard

Segmentierung

Richtig positiv

Richtig negativ

Falsch positiv

Falsch negativ

 
Abbildung 2.11: Statistische Auswertung der Snake Segmentierung im Vergleich zum Goldstandard. 
Unterschieden werden richtig positive (rp), richtig negative (rn), falsch positive (fp) und falsch 
negative (fn) Daten. Die Summe aller vier Werte ergibt die Anzahl der Bildpunkte. 
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Tabellarisch ergibt sich folgender Sachverhalt: 

 Goldstandard positiv Goldstandard negativ Insgesamt 

Positive Segmentierung rp fp C=rp+fp 

Negative Segmentierung fn rn D=rn+fn 

Insgesamt A=rp+fn B=rn+fp A+B=C+D 

 

Aus den Parametern lassen sich folgende statistische Größen berechnen: 

fnrp
rp
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+
==)(  (17) 
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rn

B
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